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Disclaimer 

The information furnished herein by Corpay is proprietary and confidential and is intended for 

Corpay customers and/or Corpay internal use. It should not be duplicated, published, or 

disclosed in whole or in part without the prior written permission of Corpay. 
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Corpay Expense Track Overview 

The Corpay Expense Track solution simplifies the process of generating, submitting, and 

approving expense reports. Designed specifically for use with Corpay Corporate credit cards, 

Expense Track allows you to manage all your expense reporting online, eliminating the 

need to keep records of paper receipts, simplifying report submission, and automating policy 

reinforcement. Furthermore, you can use Expense Track for reimbursable expenses. 

Note that Expense Track is not designed to produce payment amounts to Corpay, but rather 

to automate the input of these expenses into your accounting systems or reimburse amounts 

to employees. Use Expense Track as your one source for all expense management 

purposes in your company. 

Some key benefits of Expense Track include: 

• Alleviating the need to keep record of paper receipts 

• An Expense Track mobile app for uploading receipts, entering line items, approving, and 

*coding expenses (only available for Expense Track Premium) 

• Auto-image matching of receipts to card transactions through use of the mobile app (only 

available for Expense Track Premium) 

• Faster reimbursement for reimbursable expenses 

• Improved policy enforcement with configurable rule validation 

• Configurable approval routing automation 

• Ability to access the application from any device with internet connection 

• Google maps integration for determining miles travelled and reimbursement due 

Note: Expense Track is available in a Basic and Premium package. Some features may 

not be available depending on the package you have purchased. 
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Basics 

Expense Track Process Flow 

The Expense Track process follows two paths: reimbursable expenses and Corpay 

Corporate Mastercard expenses. The diagram below visualizes both paths. 

• Reimbursable Expenses: Reimbursable expenses are any expenses incurred without a 

Corpay Corporate credit card that can be reimbursed. These transactions can be 

captured by entering expense reports and submitting them for approval through 

automated routing. If approved and reconciled, the transaction will be exported to be 

processed through the accounting system. 

• Corpay Corporate Mastercard: All transactions performed with a Corpay Corporate 

Mastercard automatically import into Expense Track for processing. From here, you can 

edit the report as needed and send it for approval and reconciliation. If approved and 

reconciled, the expense returns to your company's accounting software system. 

 

 

  

https://corpay.com/


Expense Track     
Administrator Guide   

  

Page 8   |   Rev 1   |   11/25   |   © Corpay 2025. All rights reserved.   |   corpay.com  

 

Understand Expense Track User Roles 

It is important to understand that there are no specific user roles in Expense Track as the 

system is heavily permissions based. Each feature has an associated permission that must 

be granted to an individual user or user group, otherwise it is not accessible. 

Administrators will typically have access to all features within Expense Track while users can 

be granted access to a wide number of features, depending on what the Administrator 

deems their responsibilities. For example, if an Administrator needs an Accounts Payable 

associate to reconcile expenses, they would set them up as a user and grant their user 

profile permission to access only expense reconciliation features. Furthermore, if an 

Administrator needs several Accounts Payable associates to review expense reports, they 

can set up a user group with permissions to expense reconciliation features. Then, they can 

assign each associate to that user group. 

To break it down further, see below for a high-level understanding of Administrator 

responsibilities versus some of the responsibilities that can be assigned to users. 

 

Administrator User 

Set up Users and User Groups Create Expense Reports 

Set up Expense Types and Items Approve Expense Reports 

Grant Permissions Reconcile Expense Reports 

Run Reports 
Access Tools such as the Expense Dashboard, 

Itineraries, and Mileage Calculation 

Create and Schedule Reports 
Use the mobile app for receipt capture, expense 

reporting, and approvals 

Configure System Settings Substitute Approvers 

Manage User Access Split Account Coding 

Build Approval and Reconciliation Workflow  

Export Expense Data to Accounting Systems  

 

This is just a sample of some of the responsibilities between Administrators and users. 

Continue reading the guide for in-depth information. 
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Technical and System Requirements 

 

See the following system requirements to take full advantage of the Expense Track website. 

 

Preferred Browsers 

For optimal experience, please use the following browsers: 
 

Browser Version Comments 

Internet Explorer 11.0 If using Internet Explorer, we recommend using the latest 

version (11.0) for the best possible experience. Make sure 

to install all recommended Microsoft software updates. 

Mozilla Firefox Most recent 

version 

Corpay makes every effort to test and support the most recent 

versions of Mozilla Firefox. 

Google Chrome Most recent 

version 

Google Chrome automatically applies updates. Corpay makes 

every effort to test and support the most recent versions of 

Google Chrome. 

 

Screen Resolution Recommendations 

Expense Track is designed to be responsive with most screen resolutions. Expense Track is 

thoroughly tested using a combination of browsers and multiple screen resolutions in order 

to provide users the best possible experience. The following screen resolutions are 

recommended: 

Screen Resolutions in Pixels 

1024 x 768 1366 x 768 

1280 x 800 1600 x 900 

1280 x 1024 1920 x 1080 

1920 x 1200  

 

Note: A minimum screen resolution of 1024 x 768 is recommended. Screen resolutions 

smaller than 1024 x 768 might not properly display certain Expense Track pages. Also note, 

for all browser, you must enable JavaScript and cookies. 
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Other Technical Requirements 

 

Area Version 

Adobe Flash Player 11.0, 12.0, 13.0, 14.1, or later 

Adobe Reader 10,0, 11.0, or later 

Microsoft Excel 2003, 2007, 2010, 2013, 2016 
 

Maintenance Schedule 

 

Expense Track is available a minimum of 99.5% of the time, excluding regular scheduled 

maintenance. See below for details on Expense Track maintenance releases: 

• Major Releases: Major releases to Expense Track (example: 12.0, 14.0, etc.) occur 

annually (summer/fall) and include significant feature and functionality advances such 

as new user interface designs, extensive workflow improvements, and new 

modules or product offerings. Each time a major release is ready to deploy, Expense 

Track administrators will receive an email notification along with a release notes 

document detailing each change in the release. The release notes and 

comprehensive user and administrator guides are updated with each release and 

made available via the Help option in Expense Track. 

• Minor Releases: Minor releases to Expense Track (examples: 12.4, 14.1, etc.) occur 

every 2-3 months after a major release and include feature or functionality 

enhancements along with defect fixes. Each time a minor release is ready to deploy, 

Expense Track administrators will receive an email notification along with a release 

notes document detailing each change in the release. The release notes and 

comprehensive user and administrator guides are updated with each release and 

made available via the Help option in Expense Track. 

• Maintenance Packs: Maintenance packs are groupings of critical and high priority 

patches that are released every 3 weeks on a Monday. 

• Patches: In rare instances, a critical patch may need to be deployed outside of the 

releases mentioned above. 
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Note: Releases to Expense Track occur during a scheduled maintenance window of 

12:00am - 4:00am EST/EDT. 

Navigate Expense Track 

 

Log In 

As an Administrator, you will receive your login credentials and the Expense Track URL 

through email from Corpay. Once you receive your login credentials, follow the steps below 

the successfully log in and navigate the Expense Track web portal. 

1. Launch your web browser (Expense Track is most compatible with Internet Explorer v10 

or higher, Chrome, and Mozilla Firefox). 

2. Enter the Expense Track URL (expensetrack.com) in your browser's address bar 

and then press Enter on your keyboard. 

3. Enter your login credentials (username and password) and then click Log In. 
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If accessing the web site via mobile browser, the page will open to the full site login page. 

 

 

 

Note: If you fail to log in after four attempts, the web portal will lock you out. However, you can regain 
access through one of the following methods: 
 

• Wait 15 minutes and you can make another attempt. 

• Clear your browser's cache. 

• If you are using the Google Chrome web browser, use "Incognito Mode" located 

under Chrome's tools drop-down menu. 

• Click Forgot Password to request a temporary password. You will need to 

change the temporary password upon logging in. 
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Navigate the Expense Track Home Page 

The Expense Track home page contains quick access to key features, such as your expense 

reports, open tasks, and statuses of expenses. It is important to note that the image below is 

from an Administrator view. It is noted in the table below which features are available for 

Administrators only. 

Note: Expense Track times out after 20 minutes of inactivity. You will receive a 5-minute 

warning before the system completely logs you out. 

 

 

 

Section Description 

1. Main Menu Contains drop-down menus to all of Expense Track's features. 

2. Quick Access 

Carousel 

 

Provides quick access to your draft expense reports. 

3. Receipts 
 

Allows you to view all unassigned receipts. 
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Section Description 

 

4. Tasks 

Displays your open items, such as unreconciled expenses or items that require 

your approval. 

 

5. Status 

Displays the status of your opened expenses. For example, if you have 

expense reports that require approval, "Expense Reports in Approval" displays 

with the total number. 

 

Navigate the Main Menu 

The Expense Track main menu contains links to all the features you will use in Expense 

Track 

 

 

Menu Description 

Home Returns you to the Expense Track home page from any page in the web 

portal. 

Travel & Expenses The Travel & Expenses drop-down contains three groups of links: 

• Manage/Search: Expense Dashboard, Expense Drafts, Search 

Expenses, My Cards, Manage Card Service Requests, Expense 

Import Summary by Batch, Expense Import Summary by User 

• Filters: Open Expenses, Old Expenses, All Expenses 

• Approval/Reconcile: Pending Approvals, Approval History, 

Pending Reconciliation, Reconciled Expenses, Card Service 

Request Approvals 

Spend Manager 
Provides access to Ad-Hoc Reporting where you can run standard, 

preformatted reports. 
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Menu Description 

Settings Icon 
Offers access to all Admin-level tools. 

Speed Links 
Offers the ability to save quick links for your frequently used features. For 

example, if you want quick access to the Expense Dashboard, type it in 

the field and click Add. A quick link will be created to the Expense 

Dashboard that you can access from any page in Expense Track. 

Messages Displays all system- and user-generated notifications. 

My Cards  Displays only if a Corpay Corporate Mastercard is assigned to you. Click 

My Cards to view your card’s balance, pending and declined 

transactions, or request a credit limit increase or replacement card. 

User Name Drop- 

down Menu 

Provides access to details on the version of Expense Track, your user 

profile, a Help option, and the ability to set your in and out of office status. 

 
 

Administrator Tasks 

As an Expense Track Administrator, you are responsible for setting up and configuring Expense 

Track to be used by your company. This includes several tasks such as setting up expense 

types, expense items, approval rules, adding and managing users, applying permissions to 

users, and customizing coding types and field labels. In addition, you can monitor and manage 

your user’s activity within the site by viewing expense report drafts and approving and/or 

reconciling submitted expense reports. 

Although you can set up other users with your same Administrator access privileges, it is 

recommended Admin-level permissions be limited. This section explains and demonstrates how 

to configure Expense Track for your company's expense reporting needs and manage the 

system on an ongoing basis. 
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Click a link below for more details: 

• Set up Expense Track 

• Manage Expense Track 

• Run Reports 

 

Set up Expense Track 

Before your company can utilize Expense Track, you are required to complete certain set 

up procedures. This involves, but is not limited to, setting up individual users and granting 

them access to different features in Expense Track. Use these set up tasks to customize 

Expense Track to meet your company’s expense reporting standards and so that your 

users can navigate and perform actions in the system with no issue. 

See below for a list of setup-related tasks: 

• Set up Users 

• Set up User Groups 

• Set up Permissions 

• Set up Expense Types 

• Set up Item Categories 

• Define Expense Items 

• Set up Expense Itemizations 

• Set up Credit Card Imports 

• Set up Account Codes 

• Set up Self-Service Card Management 
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Set up Users 

 

Each employee in your company that will use Expense Track must be set up as a user. This 

includes all of their attributes such as their login credentials and contact information. 

Follow the steps below to set up individual users. 

 

Add Users 

1. On the Expense Track main menu, select the Settings icon ( ) > Users > Users. 

 

 

 

2. On the Users page, click the + symbol. 
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3. Complete each field as necessary. Required fields are denoted by an asterisk. Click Add 

User when finished to set up the user's profile. See field descriptions on the next page.  
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Field Name Description 

First Name User's first name 

Last Name User's last name 

Initials User's two-letter initial. 

Company ID User's employee number. 

NT Domain Login Valid only for use with Single Sign On. 

Manager Use the Look Up icon () to locate the user's manager, if applicable. 

Required if the user will be set up for Approval routing and escalation 

rules. 

Accounting Code User's specific default coding (example: 1001-7520-1115). 

Display Name User's full name as it will display in Expense Track. 

Login Name Username required at login (user's email address). 

Password User's password required at login. 

Password Verification Reenter the password. 

Generate Random 

Password 

Generate a random password for the user to enter on their first login. 

Email Login Information to 

User 

Emails the user their login credentials. 

Require New Password on 

First Login 

Require the user to change their password the first time they log in. 

Account Expires On Set the user's account to expire on a certain date. 

Allowed No. of Uses 
The number of times the user can log in to Expense Track. Set this 

field to -1 for unlimited access. 

Phone No. Enter the user's 10-digit phone number, mobile or landline. 

Fax No. Enter the user's 10-digit fax number. 

Email User's email address 

Spending Categories N/A 
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Field Name Description 

Spending Limits The total amount the user can spend or approve. 

Receiving Tolerance N/A 

Bill to Location N/A 

Ship to Location N/A 

Expense Location User's default location 

Related Vendor Portal 

Vendor 

N/A 

Groups Assign the user to a user group(s). 

Notify Via Select how the user will receive Expense Track notifications: 

• Internal Messaging: Messages tab on the main menu. 

• Email: The email address associated to the user's profile. 

• Both: Internal Messaging and Email. 

Language 
Current languages include: 

• English (United States) 

• Francais (France) 

• Portugues (Portugal) 

Exclude User from Rule 

Escalations 

 

Allow or disallow the user to escalate rules. 

Exclude User from 

Password Expiration 

 

Allow or disallow the user's password to expire. 

Allow Access to Expense 

Manager 

Allow or disallow the user to log in to Expense Track. 
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Other Users Page Features 

The Users page offers many other features for managing users. Select a user from the User's 

List and then select one of the following options. If you have a large list of users, use the 

Filter drop-down to filter the list by enabled or disabled users or a user group. Users can 

also be imported if you have several that need to be created at one time. 

 

 

 

 

Function Description 

Attributes View the user's profile and make changes to their password or contact 

information. 

Disable 
Disable the user's account, preventing them from logging into Expense Track. 

Enable 
Enable a disabled user's account, allowing them to log in to Expense Track. 

Copy User Copy an existing user's profile to create a new user. 

Grant Access Grant the user access to the module selected in the Available Modules 

drop-down (only Expense is available for Expense Track). 

Remove Access Remove the user's access from the selected module in the Available 

Modules drop-down (only Expense is available for Expense Track). This 

option would prevent the user from logging into Expense Track. 

Generate Token N/A 

Set In/Out Status Set the user's In Office and Out of Office status. If Out of Office, you can 
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Function Description 

specify the amount of time they will be out, return date, and a substitute to 

perform their duties. 

Substitute Approval Routes Select a substitute expense Approver if the user's initial Approver (manager) 

is not available. 

Reset Password 
Generate and email a random password to the user. 

Generate Registration Key Allows you to create a registration key that lets users self-register. If you 

select this option, you or another Administrative user will need to approve 

the request through the Users Pending Approval page (Settings icon > 

Users > Users Pending Approval. 

 

Set up User Groups 

 

User groups are similar to a user role where permissions and accesses can be 

assigned to a group and any user added to the group will inherit those permissions.  

Define 

as many user groups as necessary and customize them to your liking. For example, 

if you have several users that are responsible for approving expenses, you can create 

a group titled Expense Approvers. Some standards groups include Cardholder, Approver, 

Coder, and Administrator. However, you can customize the names and tasks of groups 

to your discretion. Follow the steps below to add user groups. 
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Add User Groups 

1. On the Expense Track main menu, select the Settings icon ( ) > Users > Groups. 

 

2. On the User Groups page, click Add. 
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3. On the Add Group page, complete each field with the attributes of the user group. Required 

fields are denoted by an asterisk. Click Add Group when finished. The new user group will 

display on the previous page. 

 

 

 

Field Name Description 

Group Name 

Enter the User Group's full name as it will display in the web portal. Example: Expense 

Approvers, Executive Administrators, etc. It is recommended the group name be prefixed 

with a special character, such as an asterisk (*). This practice keeps the user groups 

arranged together in drop- downs and distinguishes them from user names. 

Group Description 

Enter a description of the user group. For example, if the user group name is Expense 

Approver, the description could be, "users are allowed to only review and approve 

expenses". 

Group e-mail Enter an email address that can be used for all members (users) in the User Group. 

Add Members 
Add existing users to the user group. If you don't know the user's name, use the 

Look Up  icon to search for them. 
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Other User Groups Page Features 

The User Groups page offers other features for managing user groups. Select a user group 

from the Groups List and then click one of the following options. If you have a large list of user 

groups, use the Filter field to quickly search for them. 

 

 
 
 

Function Description 

 

Edit 
Edit details on an existing group, such as the group name, description, email, and members 

(users). 

 

Delete 
Permanently delete the group. If any users are added to the group, they will lose all 

accesses and permissions associated to the group. 

Spend Limits 
Set up or change spending limits. Accounting codes must be set up to use this feature. 

Reset Clears all details on the user group. 
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Set up User Permissions 

Permissions allow users and user groups to access different features and perform certain 

tasks within Expense Track. For example, if you want to grant an Expense Approver user 

group access to run reports, you would select permission 23 - Run Reports. Follow the steps 

below to assign permissions to users and user groups. 

Note: It is recommended to set permissions at the user group level. If you apply 

permissions to a user group, each user assigned to that group will inherit those 

permissions. 

 

Assign Permissions 

 

1. On the Expense Track main menu, select the Settings icon ( ) > Users > 

Permissions. 
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2. This opens the Manage User/Group Permissions page. At the top of the page, select the 

User/Group drop-down to choose a user or a user group. Select the Permissions Groups 

drop-down to choose a permission group and then click Retrieve Permissions. 

Note: When you first access the Manage User/Group Permissions page, the User/Group 

drop- down defaults to users and groups that begin with "A". Click the All button at the 

top of the page to fill the User/Group drop-down with all users and user groups. 

 

 

 

Note that permissions are separated into the 10 groups, but only the following are valid 

for Expense Track: General, Base Data, Approval, Travel and Expense, and Security. 

Review the permissions in each group to see which ones to apply to your users or user 

groups. 

Note: If you are setting up another Administrator user, ensure all permissions under 

Travel and Expense are selected except permission 2011 - Restrict to Own Expenses. 

 

3. The permissions for your selected permission group display and each permission 

assigned to your selected user or user group will be checked. If your selected user is 

assigned to a user group, the word "Inherited" displays next to each of the user group's 

permissions. 
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Select the check box next to each permission to apply it to the selected user or user 

group. Then, click Save Permissions. Continue this process for as many users or user 

groups as necessary. Click Clear All to uncheck all selected check boxes. 

Note: If you change a user's permissions, they must log out and log back into Expense Track 

for the changes to take effect. 

 

 
 

Set up Expense Types 

 

The information defined for the expense type determines the fields that are available when 

creating an expense line item. At least one expense type must be defined before moving 

ahead in the Travel & Expense setup process. Expense types also enable categorization of 

expense items when they are requested. Expense items are linked to the expense types. 

Multiple expense items can be associated with an expense type. Expense Types can also be 

imported when you have several to add at once. Follow the steps below to add expense 

types.  
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Add Expense Types 

1. On the Expense Track main menu, select the Settings icon ( ) > Expense > Expense Types. 

 

 

 

2. On the Expense Types page, click Add. 
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3. Complete all necessary fields on the Add/Edit Expense Type page. Required fields are 

denoted by an asterisk. Each field completed on this page will display on the Create an 

Expense Report page. Click Add/Edit Expense Type when finish. 

Note: Require from City and Require to City default to No if Mileage is set to Yes/Yes and 

Calculate. 
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Field Description 

Expense Type The name of the expense. For example, Hotel Airfare, Mileage, etc. 

Vendor Label The name of the label that represents the merchant or vendor field for the 

expense item. For example, Hotel Name, Airline, etc. 

Note: If left blank, the label Vendor is used. 

Quantity Label 
Label for the field that is used to specify the expense type's quantity. Example: # 

of Tickets 

Amount Label 
Label for the field that is used to specify the amount the user must enter for each 

quantity entered. For example: Amount Per Ticket. 

Description Label 
Label for the description for the expense. Example: Purpose, Attendees, etc. 

Require Date Range 
Yes: From and To date fields display on the Create Expense Report page 

No: One Date field displays on the Create Expense Report page. 

Require from City/Require 

to City 

Yes: From and To city fields display on the Create Expense Report page 

No: One City/State field displays on the Create Expense Report page. 

Require Vendor Entry 
Yes: User is required to specify a vendor when entering an expense 

No: No vendor specification required. 

Allow Amount Edit 
Yes: User can edit values in the Amount field on the Create Expense Report 

page. 

No: User is not allowed to enter a value in the Amount field. Ideal for mileage 

type expenses, where the amount per mile is reimbursed at a fixed value. The 

actual value is set up at the expense item level. 

Allow Quantity Edit 
Yes: User is allowed to edit the quantity entered on the Create Expense Report 

page. 

No: User cannot edit quantity values entered on the Create Expense Report 

page and the field defaults to 1. 

Accounts Coding Type 
Select a default accounts coding type for this expense type. When selected, all 

expense items associated to this expense type will default to your selected 
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Field Description 

accounts coding type and any global accounts coding type defaults will be 

ignored. This includes credit card imports. However, if an accounts coding type 

is set up at the expense item level, this setting will be ignored and the expense 

item's accounts coding type will apply. 

Note: This field displays only if Split Entry Field Format is selected for system 

setting 829 - Accounting Code Selection Type. 

Cost Formula The formula used to calculate the cost, if applicable. 

Quantity Formula The formula used for the quantity calculation, if applicable. 

Mileage 
• Yes: Displays the Calculate Miles button on the Add/Edit 

Expense Item page. However, if the user does not click the 

button, the miles will always calculate as 0. 

• No: Mileage calculation does not display. 

• Yes and Auto Calculate: Miles are calculated even if the user 

does not click the Calculate Miles button. 

Itinerary Item Type Associates the expensed type with a TripIt expense type. For example, if Airline 

is an option and selected, the details on this expense type will be associated to 

all TripIt airline expenses. 
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Other Expense Type Page Features 

The Expense Type page offers other features for managing expense types. Select an expense type 

and then click one of the options to the right of the Expense Type List. If you have a large amount of 

expense types, use the Filter field to quickly find one. 

 

 

 
 

Field Description 

Edit Edit the attributes on an existing expense type. 

Delete 
Remove an expense type from the web portal. Note that expense types with associated 

expense items cannot be deleted. 

Reset Clear the attributes on an expense type. 
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Set up Item Categories 

 

Item Categories enable expense items to be grouped together. Numerous Expense 

Track features are based on these categorizations. Item categories are required when 

adding items to the catalog. Item Categories are necessary for three reasons: 

• Accounting: If there are items that have different general ledger accounts, they should 

be separated and the appropriate accounting code assigned. 

• Control: If control over what parts of the catalog, users or groups of users can see, then 

they can be separated into separate categories and create rules to exclude them from 

users. This may create a situation where multiple categories carry the same accounting 

code, and this is completely acceptable. 

• Reporting: If people monitoring item usage have specific reporting needs, then 

categories can accommodate the views they require. Again, this may duplicate 

accounting codes. It may also require additional rules to be created to control proper 

access to items in the catalog. 

 

Follow the steps below to set up item categories. 

 

1. On the Expense Track main menu, select the Settings icon (             ) > 

Catalog > Item Categories. 
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2. On the Item Categories page, click Add. If you want to edit an existing item category, 

select it from the Category List and then click Edit. 

Note: The number in the brackets is the accounting code and the number in the 

parenthesis is the category ID assigned by the system. 
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3. Complete each field on the Add (or Edit) Category page. Required fields are denoted by 

an asterisk. Click Add Category when finished. See field descriptions on the next 

page. 
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Field Description 

Parent Category Select a parent category for this category, if applicable. 

Category Name Enter the name assigned to this category. Example: Stationery 

Accounting Code Enter the appropriate accounting code for this category. This code may 

be used by your accounting system. Example: ACC 

Commodity References N/A 

Default Off Catalog Item Type N/A 

Inventory/Asset 

Receiving Unit 

N/A 

Enable Off Catalog Item 

Creation Notification 

N/A 

Hide on Off Catalog Item 

Order Request 

N/A 

Auto Receive during Invoice N/A 

 

Other Item Category Features 

The Item Category page offers other features for managing item categories. Select an item 

category from the Category List and then click one of the following options. 
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Note: If you have a large list of item categories, use the Filter field at the top of the page to 

search for one. Or click the All button at the top of the page to display all of your item 

categories. 

 

 

 

Button Description 

Edit Edit an existing item category. 

Delete 
Delete an existing item category. 

Note: If an expense item is associated to an item category, it cannot be deleted. 

Category Accounts 
Assign more than one account code to an item category. See the next section for more 

information. 

Reset Clears all details on an item category and resets it to its defaults. 
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Set up Category Accounts 

Category accounts provide the ability to assign more than one account code per category. 

This could be necessary if multiple codes can be assigned to one item category based on the 

user (specifically based on the location of the user). This might be the case if there is a 

“generic” category code if they are buying a product for a corporate location and a different 

account code when they are buying that item for another location. 

This is used during the creation of a request if the user logged in has the selected location 

as their ship-to location in their user profile. When this user creates a request, the “default” 

account code in the category profile is not used when that user orders an item from the 

selected category. Instead, the code specified below is used. For example, Laura in San 

Francisco orders a pen that is for the category “Office Supplies.” The account code 

assigned to that category for that location is displayed (for example, SanFran2222). 

However, if a user from a location other than San Francisco orders this pen, then Expense 

Track uses the default category code (for example, O341). 

 

1. Select an item category from the Category List. Then, click the Category Accounts button. 
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2. Complete each field. Then, click Categories Accounts Setup. 

 

 

 

Field Description 

Category 
Select the item category for setup. Ensure this is the item category selected on the Item 

Categories page. 

Locations Use the Look up icon to select the location(s) to associate the item category. 

Account 
Enter the appropriate accounting code for this category and location combination. This code may 

be used by your accounting system. The account code can be alpha numeric (letters, numbers, 

or dashes). Example: ACC 

 

3. The category account code is added. To delete the code, click the link in the Delete 

column and it will be removed. You must delete and re-enter a category account code if 

it needs to be edited. 

 

  

https://corpay.com/


Expense Track     
Administrator Guide   

  

Page 42   |   Rev 1   |   11/25   |   © Corpay 2025. All rights reserved.   |   corpay.com  

 

Define Expense Items 

 

Expense items must be created for every individual expense type that will be requested. 

Each item is linked to an expense type that further specifies the expense item for reporting 

and coding purposes. Expense items can be imported to Expense Track if you have 

several to add at once. Follow the steps below to add expense items. 

• Add Expense Item 

• Create Default Expense Item 

 

 

Add Expense Items 

1. On the Expense Track main menu, select the 

Settings icon ( ) > Catalog > Items. 
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2. On the Items page, click Add Expense Item. 

Note: The Add button is not used to enter expense items. You must select Add Expense Item. 

 

 

 

3. Complete all fields as necessary. Required fields are denoted by an asterisk. Click Finish to 

save the expense item. 
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Field Description 

Item Name 
The expense item's name which will display on the Create Expense Report page. 

Item Description Description of the expense item. 

Account Code Value used for default coding on expenses (example: 1001-7520-1115). 

Accounts Coding 

Type 
Select a default accounts coding type for this expense item. When selected, the 

accounts coding on this expense item will default to your selected accounts 

coding type (including credit card imports). This setting ignores any accounts 

coding type defaults set at the global or expense type level. 

Note: This field displays only if Split Entry Field Format is selected for system 

setting 829 - Accounting Code Selection Type. 

Item Category Select the item category that best specifies the expense item. 

Expense Type Select the expense type that is assigned to the expense item. 

Max Allowed 

Amount 
Enter the maximum amount in dollars that your company allows for approval. If 

you enter a value greater than 0 and a user adds an expense greater than your 

amount, the system will behave as defined in the Select Approval Option field. 

Note: If the Allow Amount Edit field on the Add/Edit Expense Type page is 

set to No, the Max Allowed Amount is the reimbursable amount. Also note 

that if you are setting up a mileage expense item, use this field to enter your 

reimbursable mileage rate (example: 0.54). 

Select Approval 

Option 
Choose one of the following approval options: 

• Decline – All expense reports created that are over the maximum 

allowed amount are automatically declined. 

• Route to Manager – All expense reports that are over the maximum 

allowed amount are routed for approval to the requestor’s manager. Select 

this option if there is no approval rule setup for users in normal expense 

conditions. 

• Reimburse to Max Amount – All expense reports that are created and are 

over the maximum allowed amount will be set to reimburse the maximum 

amount only. The Approver can change the reimbursement amount if 

necessary. 
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Field Description 

Require Receipt 

above 
Enter the amount in dollars that is allowed before an expense report needs to be 

manually reviewed and reconciled so it can be released for payment. The system 

can be set up so that all expenses are matched with a receipt. 

To do this manually, set this field to a very low value. Example: 0.01 

Reimbursable Yes: The amount will allow entry and reimbursement of the amount 

entered. Ensure this field is always set to Yes, otherwise credit card 

transactions will auto-approve at $0.00. 

Require Vendor 

Selection 

No: User is not required to select a vendor during expense report creation 

Note: This field should always be No. 

Expense Advance 

Type 
No Advance: No advance is allowed for this expense item. 

Advance Only: Select this option only if an advance can be claimed for this 

expense item. 

Customer Field Label 

1-3 

Used to label custom fields for capturing any additional information. 

Merchant Category 

Code (MCC) 
Restrict the expense item to one or more MCCs using the Look Up icon  

Note: MCCs are pre-loaded into Expense Track during account 

implementation. When expense items are associated with MCCs, the credit 

card transactions are automatically associated with that item when it is 

imported into the system. Each MCC can be mapped to multiple expense 

items. When an item is imported that has multiple MCCs, the transaction 

defaults to the first item. 

 

Create a Default Expense Item 

As you add expense items, ensure you create a default expense item. Default expense 

items are items that imported credit card transactions will match to if the import 

map fails. Once the transaction enters the system, it will display on an expense 

report in red flag status ( ) and with no editing options. The user will need to only 

select the correct expense item to fix the transaction. 
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Ensure the default expense item has a name that is different from your other expense 

items. An example name of a default expense item may be "Select Expense Item", "Default 

Expense Item", or "Unmatched Expense Item". For more information, see the topic Correct 

Unmatched Credit Card Transactions. 

Set up Expense Itemizations 

 

Expense itemizations enable you to further break down an expense item into itemized 

details. For example, a lodging expense item can be further broken down into room rates, 

taxes, entertainment, etc. Follow these steps to add expense itemization fields. 

Note: Expense itemizations are only valid for reimbursable out of pocket expenses as credit 

card transactions display this information in the associated level 3 transaction data. 

 

Add Expense Itemizations 

1. On the Expense Track main menu, select the Settings icon ( ) > Expense > 

Expense Itemizations. 
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2. On the Expense Itemizations page, click Add. 

 

 
 

 

3. Complete each field as necessary. Required fields are denoted by an asterisk. Click 

Add/Edit Expense Itemization Field when finished. 
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Field Description 

Expense Item Select an expense item from the drop down list. 

Itemized Field Name Enter a name for the itemized field. 

 

Required 

Yes: The Expense Item field becomes required when entering an expense 

report. 

No: The Expense Item field becomes unrequired. 

 

Reimbursable 

Yes: The amount will allow entry and reimbursement of amount entered. No: 

The system deducts the value of this expense from the total reimbursement 

value. 

 

Max. Reimbursable 

Amt. 

Enter the maximum amount for the expense itemization in dollars that the 

company will reimburse. If specified, the system will only reimburse up to this 

amount for any expense itemized in this field. 

Default Amount Enter the default amount for this field. Example: 0 

 

Field Order 

Enter a numeric value, which decides the order in which the added fields are 

displayed in the Itemization Entry page when more than one field is added. 

Multiple Itemization 

Type 

Select Date to provide multiple records for the selected Expense Type for the 

same expense report. 

 

Set up Credit Card Imports 

 

Expense Track offers the ability to set up how and when credit card data imports 

into the website. This can be done under Settings icon ( ) > System > System 

Settings. 

Credit Card Import 

Use Automatic Receipt Matching (2300) 

  

https://corpay.com/


Expense Track     
Administrator Guide   

  

Page 49   |   Rev 1   |   11/25   |   © Corpay 2025. All rights reserved.   |   corpay.com  

 

System Summary Description 

Use this setting to enable or disable automatic receipt matching for a tenant. 

 

Business Background 

When enabled, the system automatically associates uploaded receipts to expense line items 

if the amount and date match. Automatic matching is triggered when level 3 credit card 

transactions are imported into the system, a user uploads a receipt, or a user views expense 

line information. Automatic matching increases the speed in which expense drafts requiring 

receipts can be created, approved, and reconciled. 

• Multi-Tenant Type: Tenant [3] 

• Valid Values: Yes or No (expected value is Yes) 

• Default setting: No 

• Responsibility: This setting is created/enabled during the implementation process 

Number of days before Receipt Reminder is sent (2301) 

 

System Summary Description 

This setting determines how many days a receipt can exist in the system without being 

matched to an expense line before a notification is sent to the user. 

 

Business Background 

For tenants with automatic receipt matching enabled, the notification alerts users when an 

uploaded receipt cannot be matched and must be manually associated with an expense line 

item. For tenants without automatic receipt matching, the notification is triggered for all 

receipts that are not associated to an expense line item. This tool helps ensure that all 

receipts are properly associated with expense items, making approval and reconciliation 

more efficient. 

• Multi-Tenant Type: Tenant [3] 

• Valid Values: Any positive numeral, up to 255 characters. 
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• Default setting: 2 

• Responsibility: This setting is created/enabled during the implementation process. 

Draft Naming Convention (2305) 

 

System Summary Description 

This setting determines how the system names expense drafts generated for imported 

credit card expenses. 

 

Business Background 

The expense draft name decides which information is most readily visible to expense draft 

viewers and approvers. Some users may prefer to see the credit card name, some the 

expense period, and some the associated user’s name. 

• Multi-Tenant Type: Tenant [3] 

 

• Valid Values: 

o Expense Period 

o Name - Expense Period 

o Card Number - Expense Period 

o Card Name - Expense Period 

• Default setting: Expense Period 

• Responsibility: This setting is created/enabled during the implementation process. 

Credit Card Expense Report Cycle Frequency (2310) 
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System Summary Description 

This setting determines how often the system generates new expense drafts for imported 

credit card expenses. 

 

Business Background 

Some businesses track credit card expenses at different frequencies, such as weekly, twice a 

month, or monthly. Generating new expense drafts that match these processes allows for 

more efficient expense tracking and approval. 

• Multi-Tenant Type: Tenant [3] 

• Valid Values 

o Weekly 

o Semimonthly 

o Monthly 

o Calendar Month 

• Default setting: Calendar Month 

• Responsibility: This setting is created/enabled during the implementation process. 

 

First Day of Week for Expense Report Cycle (2311) 

System Summary Description 

Determines the day of the week on which the credit card expense report cycle begins for 

weekly expense draft creation. Only used if system setting 2310 - Credit Card Expense 

Report Cycle Frequency is set to Weekly. 

Business Background 

Allows the user to customize the expense draft creation to match their weekly expense 

tracking. 

Multi-Tenant Type: Tenant [3] 
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• Valid Values 

o Sunday 

o Monday 

o Tuesday 

o Wednesday 

o Thursday 

o Friday 

o Saturday 

• Default setting: Monday 

• Responsibility: This setting is created/enabled during the implementation process. 

 

Day of Month for First Credit Card Expense Report Cycle (2312) 

 

System Summary Description 

Determines the day of the month on which the billing cycle begins for monthly or semi- 

monthly expense draft creation. Only used if system setting 2310 - Credit Card Expense 

Report Cycle Frequency is set to Monthly or Semimonthly. If billing cycle is semimonthly, 

this setting sets the day for the first billing cycle of the month. 

Business Background 

Allows the user to customize the expense draft creation to match their monthly or 

semimonthly expense tracking. 

• Multi-Tenant Type: Tenant [3] 

• Valid Values: Drop-down list, 1-28 

• Default setting: 1 

• Responsibility: This setting is created/enabled during the implementation process. 
 

Day of Month for Second Credit Card Expense Report Cycle (2313) 
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System Summary Description 

Determines the day of the month on which the second credit card expense cycle begins for 

semimonthly expense draft creation. Only used if system setting 2310 - Credit Card Expense 

Report Cycle Frequency is set to Semimonthly. This setting must be greater than the value 

set in system setting 2312 - Day of month for First Credit Card Expense Report Cycle. 

 

Business Background 

Allows the user to customize the expense draft creation to match their semimonthly 

expense tracking. 

• Multi-Tenant Type: Tenant [3] 

• Valid Values: Drop-down list, 2-28 

• Default setting: 15 

• Responsibility: This setting is created/enabled during the implementation process. 

 

Default Expense Item for Unmatched CC Transactions (2320) 

 

System Summary Description 

Allows you to enter a default expense item for unmatched credit card transactions. Ensure 

the default expense item has been set up before assigning it. Do not assign an expense item 

that is normally in user (example: Travel, Airfare, Mileage, etc.). It is mandatory to set up 

this setting. 

 

Business Background 

Allows the user to default all unmatched credit card transactions to a unique expense item. It 

is mandatory to set up this system setting, as unmatched credit card transactions will not enter 

Expense Track otherwise. 

Multi-Tenant Type: Tenant [3] 
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Valid Values: Any default expense item (example: Default Expense Item, Unmatched 

Expense Item, etc.) 

Default setting: Blank 

• Responsibility 

This setting is created/enabled during the implementation process. 

 

Additional System Settings 

Enable Attachment/Receipt Requirement for Expenses (2161) 

System Summary Description 

Allows you to require receipt images on all expense reports. You can require receipt images 

at the report header level, line item level, or both. Although there is a Disabled option, 

Expense Track requires all expense reports to have receipt images. 

Note: If the transaction amount is a negative (a credit), this setting is ignored. 

 

 

Business Background 

Required receipt images help keep track of transactions for accounting purposes. 

 

Multi-Tenant Type 

Tenant [3] 

Valid Values 

• Disabled 

• Header Level 

• Item Level 

• Header or Line Level 
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Default Setting 

Line Level 

Responsibility 

This setting is created/enabled during the implementation process 

Accounting Code Selection Type (829) 

System Summary Description 

Determines if users will manually enter or select accounting codes from a list. 

 

Business Background 

This setting allows you to determine how users will enter accounting codes on expense 

items. 

Multi-Tenant Type 

Tenant [3] 

Valid Values 

• Text Entry: Users can freely enter accounting codes in a text field 

• Selectable: Users can select accounting codes from a list or enter them in a text field 

• Selectable (Text Entry Disabled): Users can only select accounting codes from 

a List 

• Look Up: Users can select accounting codes from a pop-up window as well as enter 

them in a text field 

• Look Up (Text Entry Disabled): Users can only select accounting codes from a pop-

up window 

• Split Field Entry Format: Users can select accounting codes from different segments 

Default Setting: Text Entry 

Responsibility 

This setting is enabled during the implementation process. 

https://corpay.com/


Expense Track     
Administrator Guide   

  

Page 56   |   Rev 1   |   11/25   |   © Corpay 2025. All rights reserved.   |   corpay.com  

 

Enable Notes Field for Split Coding Entry 

(898) System Summary Description 

When enabled, the Coding Notes field is displayed on the Split Account Code page wherever 

present in the Expense Track website. If the user chooses to apply split coding information to 

additional items on an expense report, the coding notes are also copied over to the other selected 

items. 

Business Background 

Coding notes allows a user or an approver to make comments about the accounts coding 

applied to an expense item. 

Multi-Tenant Type 

Tenant [3] 

Valid Values: Yes or No 

Default Setting: No 

 

Account Coding Split Templates 

Overview 

The Account Coding Split Templates feature in Corpay ExpenseTrack enhances the efficiency and 

consistency of expense coding. System Administrators can now create reusable templates that define 

pre-configured splits and coding values, streamlining the expense entry process for users. 

Feature Activation 

To enable this functionality: 

• Turn on the system setting Enable Accounts Coding Split Templates (2125). 

• Set the Accounting Code Selection Type (SS 829) to Split field entry format. 
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Creating Templates 

A new menu item titled Accounts Coding Split Template is available under the Accounting section. This 

opens the Manage Accounts Coding Split Templates screen. 

Administrators with the Manage Accounts Coding Split Templates (4225) permission can: 

• Add, update, and delete templates. 

• Mark any template as default for the tenant. 

• Delete multiple templates in bulk. 

• Use filters to efficiently manage and organize templates. 

 

Applying Templates 

Users with the Can Split Account Codes (63) permission can apply templates when editing expense 

drafts. The template selection panel appears: 

• Directly below the splits section on the Add/Edit Expense Item screen. 

• In the Manage Transaction Grid. 

The default template is auto-selected, and users can choose from other available templates via a 

dropdown menu. This allows for quick and consistent coding across transactions. 

 

Set up Account Codes 

Account codes are general ledger (GL) numeric values used to assign transactions 

to specific entities within your company. This allows your cardholders to associate 

expenses to different divisions and projects, which ultimately helps correctly allocate 

costs. This feature is especially useful if your users will split account codes or export 

accounting files into an Accounts Payable system. 

Typically, your Corpay Implementation Specialist will set up account codes for you during 

your Expense Track setup. However, you can add or edit account codes at any time after 

setup. For best practice, consult a Corpay representative before configuring account codes 

to avoid causing problems. 
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Click a link below to learn more: 

• Set up Accounting Codes 

• Set up Accounting Code Groups 

• Set up Accounting Periods 

• Manage External Account Codes 

 

Set up Accounting Codes 

Although a Corpay Implementation Specialist will set up your account code structure, you can 

add or edit account codes at any time. Follow these steps to add/edit an account code. 

1. On the Expense Track main menu, select the Settings icon ( ) > Accounting > 

Account Codes. 
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2. The Account Codes List page displays with a list of all account codes within your 

Expense Track instance. Click the + symbol to enter a new account code (or 

select an account code from the list and then click the pencil icon to edit ). 

 

 

 

3. Complete each field. Required fields are denoted by an asterisk. 
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Field Name Field Name 

Accounting Code The numeric value for the account code. 

Account Type The type of account code, including: 

• Global: the code can be used by every department or project in 

the company. 

• Location: specify a specific location for the account code 

• Group: create an account code for a specific user group 

• User: create an account code for a specific user. Only the user with 

the appropriate reference ID can use this account code. 

• Default Code: default all expense items to this account code 

selection. 

• Use Tax: enable only a specific set of codes to be entered as 

valid use tax account codes. 

• Freight: set account codes by freight expenses. 

• Custom 1-3: set custom account codes for other business needs. 

Reference ID Enter a reference ID if the Account Type is User, Group, or Location. 

Accounting Code Group The accounting code group to assign the account code. 

Description A description of the account code. 

Default For If Default Code is selected as the Account Type, use this field to enter 

what the default is. 

Parent Account Codes If applicable, enter any parent account codes. 

Enabled Yes - active 

No - inactive 

 

4. Click Add/Edit Accounting Code to finish. Your new/edited account code will display 

in the list on the Accounts Code List page. 
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Set up Accounting Code Groups 

Accounting code groups allow you to associate a range of account codes to a group. 

This feature is useful for easily managing account codes in a group rather than individually. 

Note that the account codes should be created first before you assign them to a group. 

 

1. On the Expense Track main menu, select the Settings icon > Accounting 

> Accounting Code Groups. 
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2. The Accounting Code Groups List page opens with a list of all your accounting 

code groups. Select one of the options on the right side of the page. 

 

 

 

Add/Edit an Accounting Code Group 

1. Click Add to create a new accounting code group (or select one from the list 

and then click Edit). 

2. Enter a name for the accounting code group. Then, click Add Accounting Code Group. 

 

 

 

3. The accounting code group will display in the list. 
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Download an Accounting Code Group 

This option allows you to download an Excel spreadsheet of all account codes 

within the group. Use this feature to keep a physical record of all account 

codes within your accounting code groups. 

 

Assign/Unassign Account Codes 

Once you've created an accounting code group, you can begin assigning it 

account codes. 

1. Select an existing accounting code group from the list, and then click Assign. 

2. The Assign Codes Step 1 page opens. The page initially opens blank and provides 

fields for assigning and unassigning account codes. To populate the page with 

account codes, select an Account Type and then click Retrieve. 

 

Note: The Show All Unassigned check box prompts the system to display only 

unassigned account codes when Retrieve is clicked. When Show All Unassigned 

is selected, the system ignores the Account Type selection and any value entered 

in the Search Account Code field. All unassigned account codes in the system 

will display. 
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3. The page will populate with all assigned and unassigned account codes. To assign 

an account code to the group, select the check box next to it and then click the 

arrow icon. To unassign an account code, select it from the Assigned Account Codes list 

and then click Remove. 

 

 

 

4. After making your selections, click Finish. You will be returned to the Accounting 

Code Groups List page with a success message. 
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5. To unassign all account codes from a group, select the group from the list 

and then click Unassign. 

 

 

 

6. Click Yes to complete unassigning the account codes. 

 

 

 

You will be returned to the Accounting Code Group List page with a success message. 
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Set up Accounting Periods 

If your company's accounting periods change, you can apply those changes within 

Expense Track to avoid issues of processing expense reports. Normally, 

accounting periods are already set up for you, but you can edit these at any time. 

1. On the Expense Track main menu, select the Settings icon ( ) > 

Accounting > Accounting Periods. 

 

 
 

 

2. The Accounting Periods page opens with a grid of all accounting periods set up for 

your company. Click the plus button (      )  to add a new accounting period. 
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3. Enter the Start Date and End Date of the accounting period. Optionally, you can 

enter a name for the accounting period if necessary. Click Submit when 

finished. 

 

 

 
 

Note: Be aware of the following as you create accounting periods: 

• The End Date must be equal to or greater than the Start Date. 

• When creating a new accounting period, the Start Date will default to the first 

available date that falls after the latest End Date in the grid. For example, if the 

latest 

• End Date is Friday, January 27, the next available Start Date is Monday, January 30. 

• Accounting Periods cannot overlap. 

• Start Dates begin at 12:00:00 am of the date selected. End Dates end at 11:59:59 

pm of the date selected. 

• If editing, the Start Date and/or End Date will be read-only fields if those dates have passed. 

• You cannot delete accounting periods. If you add an accounting period in error, 

contact a Corpay representative to have it removed. 
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4. Your accounting period now displays in the grid on the Accounting Periods page. 

Note: To edit an existing accounting period, select the check box for the 

period you want, and then click the edit icon. 

 

Manage External Account Codes 

If your account code information is stored in an external data source (i.e., an 

accounting system or ERP), you will need to use Corpay’s Export Sync Tool to 

export and configure your account codes in Expense Track. When your account 

codes are exported and stored in the Expense Track database tables, you can add, 

edit, and delete each accounts coding. 

Note: System setting 975 - Accounts Coding External Datasource must be 

enabled to access the Manage External Accounts Coding page. 

 

1. On the homepage select the system settings icon (      ) >accounting > external account 

codes. 
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2. The Manage External Account Codes page opens. Use the Select Table drop-down to select 

a table you wish to edit, then click Refresh to display the account codes in your selected 

table. 

Note: The first table in the database will display by default. 

 

 

 

3. To add an account code, click the plus icon. 

4. The Add External Account Code page opens. Complete each field and then click Add 

Account Code. 
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Field Description 

Table Select the table for which the account code will be added. 

Account Code* The numeric value for the account code. 

Description Enter a description of the account code (example; Equipment, Construction 

and Service, Projects, etc.). 

Reference ID Enter a reference ID if the Account Type is User, Group, or Location. 

Account Code Group If available, select the accounting code group to assign the account code. 

Account Type The type of account code, including: 

• Global: the code can be used by every department or project in your 

company 

• Location: specify a specific location for the account code 

• Group: create an account code for a specific user group 

• User: create an account code for a specific user. Only the user with 

the appropriate reference ID can use this account code 

• Default Code: default all expense items to this account code selection 

• Use Tax: enable only a specific set of codes to be entered as valid 

use tax account codes 

• Freight: set account codes by freight expenses 

• Custom 1-3: set custom account codes for other business needs 

ParentRef1 If applicable, enter any parent account codes. 

Enabled Yes - active 

No - inactive 

 

5. The account code will now display in the list of account codes for your selected table. 

 

6. To edit an account code, select an account code in the list. Then, click the pencil icon. 
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7. The Edit External Account Code page opens. Complete each field, then click Edit Account 

Code. 

 

 
 
 

8. The edits will be applied to your selected account code. 

9. To delete an account code, select it from the list and then click the Delete icon. You will be 

prompted to confirm deletion. This action is useful if an account code is set up incorrectly or 

is no longer used. 
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Set up Self-Service Card Management 

If your users are assigned a Corpay Corporate Mastercard, they will have the ability 

to view their card’s balance, credit limit, and transaction activity, or submit a request 

for a credit limit increase or replacement card. All of this can be done right within 

Expense Track. This feature eliminates many of the manual efforts involved with 

corporate card service requests, such as filling out paper forms and tracking each 

request. By adding this ability to the Expense Track website, you can manage card 

service requests from one location. 

Note: The user must have at least one Corpay Corporate Mastercard assigned to them. 

Also, the following permissions/system settings are needed in order for users to access 

this feature: 

• (172) Manage Data Attributes. Needed for Administrators to set up card request 

rules and parameters within Expense Track. 

• (2020) Manage Card Service Requests. Assign this permission to users that will 

be responsible for reviewing and approving credit limit increase and card 

replacement requests. By selecting this option, you can configure approvals by 

location or location groups. 

• System Setting (1195) Enable Summary Approval/Decline from Approval List. 

Ensure this system setting is set to Yes as it is also required for approvers to review 

and approve card service requests. 

• System setting (2031) Electronic Signature for Credit Card Limit Increase Requests 

(Optional). This is an optional system setting that you can apply if you require an 

electronic signature for card service requests. You can require users to enter their 

password, employee ID, or email upon submitting a request. 

Click a link below to learn more: 

• Set up Card Service Request Data Attributes 

• Set up Card Service Request Approval Rules 

• Approve and Process Card Service Requests  
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Set up Card-Service Request Data Attributes 

In order for users to submit credit limit increase and card replacement request, you 

must set up data attributes. Users will receive an error when attempting to submit a 

request until you set up the appropriate forms. 

1. To access the setup process, select the Settings icon ( ) > Other Data > Manage 

Data Attributes. 

 

 

 

  

https://corpay.com/


Expense Track     
Administrator Guide   

  

Page 74   |   Rev 1   |   11/25   |   © Corpay 2025. All rights reserved.   |   corpay.com  

 

2. This opens the Data Attributes Type List page; click Add. 

 

 

 

3. Enter a name for the data attribute and ensure the name reflects the request you intend 

to create. For example, if you’re creating a card replacement request, enter “card 

replacement” or something similar. 
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4. Ensure the information is entered correctly, then click Finish. 

 

 

 

5. You will be returned to the Data Attributes Types List page. Select the data 

attribute you created, then click Manage Data Attributes. This is where you’ll 

create the fields that will display on the forms needed to submit card service 

requests. 
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6. The Data Attributes List page opens; click Add. 

 

 

 

7. Complete each field, then click Next. 
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Field Name Description 

Data Attribute Name Enter a label for the field. 

Attribute Field Type Select the type of field to create. Options include: 

• Checkbox 

• Currency 

• Date 

• Display 

• File 

• Image 

• Lookup 

• Number 

• Radio Button 

• Text Box 

• Text area 

Sort Order Determines where the field will display on the form (0 = appears first, 1 = 

appears second, etc.). 

 

8. Complete each field on Step 2 to further define the data attribute. The displayed 

fields vary depending on the value selected in the Attribute Field Type field in 

Step 1. When finished, click Save. Repeat this process to add as many fields as 

necessary to the card service request form. 
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9. Once all fields are applied, return to the Data Attributes Types List page, select 

the data attribute type you created, and then click Publish. The data attribute is 

now live and your users can make card service requests from the My Cards 

page. 

10.  
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Set up Card Service Request Approval Rules 

After you complete setting up the data attribute, you can apply approval rules if your 

company requires card service requests to follow an approval process. 

1. To access the Rules Wizard, select the Settings icon (    ) > Users > Rules. 

 
 

2. Click the + icon to create a rule. 

 

3. In Step 1, set up the basic details on the rule, such as the rule name, start and 

expiration date, and priority. Ensure the Rule Type field is set to Card Service 

Request and Applies to Expense is set to Yes. Click Next when finished. 
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4. In Step 2, set up additional details on the card service request rule, such as 

the Rule Class (Replacement Card Request, Card Limit Increase Request), 

optional exception information, and the Rule Restrictor (None, Location 

Group/Location, User Group/User). Click Next when finished. 

 

 

 

5. If you selected Location Group/Location or User Group/User, Step 3 allows 

you to select your users or locations the rule will apply to. If you selected None 

in the Rule Restrictor field, meaning the rule will apply to all users, Step 3 will 

ask you to select an approval routing type. Make your selection and click 

Next. 
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Routing Type Description 

Stop The request will not be sent to any other users for approval. However, this option 

prevents users from submitting a card service request. 

Chain Allows you to select a series of users to review and approve requests. 

Parallel Allows you to select multiple approvers; if one user in the group approves the request, the 

other users will not need to approve it. 

Manager Each request will need to be approved by the user’s manager. 

Org Tree Allows you to specify the levels in your organization the request must follow. 

 

6. If you selected Chain or Parallel, Step 4 asks you to select the users to 

include in the approval chain. Once you add a user, use the Move Up and Move 

Down buttons to determine the order users will need to approve the request, 

with the top user being first in the chain. Make your selections, then click 

Finish. 
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If you selected Org Tree, you can specify the levels in your organization the 

request must follow. For example, if 2 levels are selected, then the request 

must be approved by the user’s manager and the manager’s manager. 

 

 
 

If you selected Stop or Manager, the rule set up is complete and you will be 

returned to the Rule List page. 

 

7. Once you are finished setting up the rule, select it on the Rule List page and 

then click Enable Rules. The rule is now applied based on your settings. 
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Approve and Process Card Service Requests 

Once a user submits a card service requests, and you have applied the appropriate 

approval rules, you or any user you deem responsible can review and approve 

requests, and submit them for processing. 

Note: Remember, in order to approve and process card-service requests, the following 

permissions and system settings are required: 

•  (2020) Manage Card Service Requests. Assign this permission to users that will be 

responsible for reviewing and approving credit limit increase and card replacement 

requests. By selecting this option, you can configure approvals by location or 

location groups. 

• System Setting (1195) Enable Summary Approval/Decline from Approval List. 

Ensure this setting is set to Yes as it is also required for approvers to review and 

approve card service requests. 

• System Setting (2031) Electronic Signature for Credit Card Limit Increase 

Requests 

(Optional). This is an optional system setting that you can apply if you require an 

electronic signature for card service requests. You can require users to enter their 

password, employee ID, or email upon submitting a request. 

 

Approve Card Service Requests 

1. To access card-service requests that are in approval, select Travel & Expense > Card 

Service Request Approvals. 
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2. The Card Service Requests to Approve page contains each requests requiring your 

review. Select the check box for a request and then click either Approve or Decline. 

If there are multiple approvers in the approval route, you can click Return to send a 

request back to the previous approver. 

 

 

Note: Click the Reference No. to review details on a request. 

 

3. Click OK on the confirmation popup. 

 

Note: If you decline a request, you will need to enter a reason for your decline. 
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• The request is approved and removed from the list. The requestor will receive a 

message notifying them of your approval. If there is an approval chain, the next 

user in the chain will receive a notification message telling them they need to 

approve the request. 

 

 

Process Card Service Requests 

After a request is approved and ready to be processed, an email is sent to all users with 

permission 2020 – Manage Card Service Requests for the requestor’s expense location. The 

processing user can reject or submit a request for processing. 

Note: Direct integration with the card management system will be available at a later date. 

At this time, credit limit increases and replacement cards must be processed in 

iConnectData and then marked as processed in Expense Track to track the status of the 

request. 

 

1. To process card service requests, select Travel & Expense > Manage Card 

Service Requests. 
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2. Select a request and then click the check mark button ( ) to mark it as processed 

or click the x button ( ) to reject it. To review the details on a request, click the 

Reference No. 

 

 

 

3. You will receive a success message upon confirming your selection. The Status 

column reflects the action the approver user took on the request (Approved, 

Declined, New/In Approval) or the action you performed (Processed, Rejected). 

These requests are never removed from this page, so you can always come back and 

search for past requests if needed. 

Note: You can only process or reject requests in Approved status. 
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Manage Expense Track 

Once all of the set up pieces are complete, you can begin using and managing Expense Track. A 

common task for Administrators is to ensure data is accurate and current within the system. 

You can also change system settings, add and delete user accounts, and approve or decline 

expense reports. You can perform many of the same operations as your users (see the 

Expense Track user guide for more information), but there are some Administrator-specific tasks 

such as reconciling expense reports and correcting credit card transaction data. 

See below for a list of management tasks: 

• Correct Unmatched Corpay Mastercard Transactions 

• Assign Delegate Users 

• Approve Expense Reports 

• Reconcile Expense Reports 

• Extract Expense Data 

 

Correct Unmatched Corpay Mastercard Transactions 

 

All transactions performed with a Corpay Mastercard are imported into Expense Track and 

collected into draft expense reports. These draft expense reports are auto-created based 

on your company's expense period (weekly, semi-monthly, monthly, etc.). The 

transactions for the expense period match to reports based on the user, customer ID, 

and expense item (transaction detail). The transactions themselves match to an 

expense item based on the Mastercard Merchant Category Code (MCC). 

When Corpay Mastercard data is imported into Expense Track, the users associated to 

each line item will receive a notification in Expense Track Messages, informing them of the 

import. You can define how often Expense Track generates draft expense reports for imported 

Mastercard transactions. For example, if the frequency is set to monthly, your users 

will receive a draft expense report for all transaction for the previous month. Understanding the 

credit card expense draft frequency allows for efficient expense tracking and approval. 
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However, transactions may fail to match to the correct expense item if an error occurs 

in the mapping. These are known as unmatched transactions. In this situation, users 

cannot submit the expense report until they match the transaction to the correct 

expense item. There are multiple avenues for correcting unmatched transactions. Users will 

also receive notifications in Expense Track Messages of the failed matched items. The 

notification will be sent every day until the user corrects the expense item. 

Note: Only posted Corpay Mastercard transactions display in Expense Track. 

Transactions generally appear 24 hours after the posting date except for Sundays. 

 

Click a link below to learn more: 

• Correct Corpay Mastercard Transactions on Expense Reports 

• Correct Corpay Mastercard Transactions By Batch 

• Correct Corpay Mastercard Transactions by User 

 

Correct Corpay Mastercard Transactions on Expense Reports 

If a Corpay Mastercard transaction fails to match to an expense item, it will match to the 

default expense item you defined at set up. If this happens for you or your users, you can 

make a correction on the expense report. 

 

Note: You cannot correct transactions for another user on their expense report unless you 

are assigned as a Delegate user. However, you can do so through the Expense Import 

Summary by Batch page. 
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1. Access the Expense Dashboard (Expense Track home page > Travel & Expense > Expense 

Dashboard). 

 

 

 

2. Open an expense report you know has unmatched Corpay Mastercard transactions. 
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3. Unmatched transactions display in the Expense Items table in red flag status and only the 

Move icon is available in the Actions column. The Item column displays the default 

expense item in a drop-down menu (in the example below, it is labeled Please Select). 

Use the drop-down menu to select the correct expense item. Then, click Save. 

 

 

 

4. The expense item may not change to green-flag status, but now you have all options to edit 

the expense report. Repeat this process for all unmatched expense items. 
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Correct Corpay Mastercard Transactions by Batch 

As an Administrator, you can monitor all imported Corpay Mastercard transactions through 

the Expense Import Summary by Batch page. Use this page to view matched and 

unmatched credit card transactions by daily batches and make corrections as necessary. 

1. On the main menu, select Travel & Expense > Expense Import Summary by Batch. 

 

 

 

 

2. The Import Summary by Batch page opens with a table list of all batches. Each batch 

displayed on this page contains up to 24 hours of posted transactions. Click a batch ID to 

view transaction details. 
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Note: Use the Filter button ( ) to narrow the results in the table. Use the More Actions 

button to export selected rows or the entire table to an Excel spreadsheet. 

 

 

 

3. The Card Transaction Detail page opens with info on each transaction in the batch. 

Transactions that enter unmatched will be in Exception status and the Exception Type 

column explains the reason for the exception. If the transaction is in Processed status, 

edits can be applied only from the Edit Expense Report page. Select a row(s) using the 

check boxes in the far left column and then select the More Actions drop-down to 

perform one of the following actions: 

• Archive. Archives the transaction so it cannot be edited or submitted. Note that this 

does not delete the transaction from Expense Track. 

• Reprocess. Sends the transaction for reprocessing to add to an expense report. 

• Edit Transactions. Assign the transaction(s) to an existing user or expense item. 

• Create Users. Create a new user and assign them to an expense item. 
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• Export current view. Export all selected rows to an Excel spreadsheet. 

• Export All Rows. Export all rows to an Excel spreadsheet. 

 

 

 

4. For this example, we selected a transaction missing a user ID and then selected Edit 

Transactions to fix the discrepancy. This opens the Edit Transaction window. From here, 

enter the correct expense item and user ID. Be aware that you must enter an existing 

user ID and spell the name correctly. Click Submit when the error is fixed. 
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5. Return to the Card Transaction Detail page to see the credit card transaction tied to a 

user. Notice that the user has been added but the transaction is still in Exception status. 

Select Reprocess from the More Actions drop-down to send the item for processing onto 

an expense draft. If successful, the status will change to Processed. 

Note: To view detailed information on a transaction, either click the transaction ID in the ID column 

or select a check box and then click the eye icon . 

 

 

 

Correct Corpay Mastercard Transactions by User 

The Expense Import Summary by User page allows you to review imported Corpay Mastercard 

data that has been associated to a user. If you grant a user permission to view this page, they 

will see only their transactions. As an Administrator, this page is similar to the Expense Import 

Summary by Batch page, but includes the total amount spent in each batch. 

 

1. On the Expense Track main menu, select Travel & Expense > Expense Import 

Summary by User. 
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2. The Import Summary by User page opens with a table list of all transactions grouped 

into batches. Similar to the Import Summary by Batch page, each batch contains up to 

24 hours of your posted transactions. Click a link in the Batch ID column to view a 

batch's transaction details. 
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3. The Card Transaction Detail page opens with info on each transaction in the batch for 

each of your users. You can perform the same edits here as mentioned in the Correct 

Corpay Mastercard Transactions by Batch section. 

 

 

Assign Delegate Users 

 

The Delegate User feature of Expense Track allows your users to assign other users as 

delegates to manage their expense reports. As an Expense Track Administrator, you can 

assign one user as a Delegate for one or multiple other users. This feature is useful if a user is 

out of the office or never accesses the website to manage their expenses. Follow the steps 

below to set up a Delegate user. 
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Note: Permission 4120 - Manage User Delegates must be selected to use this feature. 

 

1. On the Expense Track home page, select the Setting icon  > Users > 

User Delegates. 

 

 

 
 

2. Complete each field to set up the Delegate user. See field descriptions below. Note that 

each field is a typeahead field, meaning if you enter a few letters or numbers, matching 

results will display. 

Note: If you enter values in the Individual Users, User Groups, and Location Groups 

fields, or a combination of two of the fields, the Delegate user will have access to 

each user within the selected segments. 

For example, if you enter Group A and Group B in User Groups, and Location A and 

Location B in Location Groups, the Delegate user will be assigned to each user in 

each group. 
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Field Description 

User Enter the user ID of the Delegate user. 

Can Act On Expenses is the only option in this field, as this is the only task Delegate 

users can perform for other others. 

As a Delegate 

For 

• Specify Below: Select this option if you will enter users in the 

Individual Users, User Groups, and/or Location Groups fields. 

• All Users: Select this option to delegate the user to all other users 

in the system. For example, if an accountant associate needs to 

access all users' expenses to help them understand the process of 

creating and submitting 

expense reports, select this option. 

Individual Users Enter one or multiple users IDs. 

User Groups Enter one or multiple user groups. 

Location Groups Enter one or multiple location groups. 
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3. Click Update at the bottom of the page. The Delegate User is now assigned to the 

user(s) you selected. 

 

 
 

Approve Expense Reports 

 

Once a user submits a draft expense report, it must go through approval at your company’s 

management level. Review each report to ensure there are no issues. You can approve an 

entire expense report or each expense item in a report. You should have defined approval 

rules during the expense track set up process. 

Select a task below for more details: 

• Approve Expenses 
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Approving Expense Reports 

 

Use this section to understand how to approve expense reports. You can approve an entire 

report or each specific expense item in a report. Also, note that you can approve expense 

reports within the Expense Track website or from the notification email. 

• Approve Expense Reports in the Website 

• Approve Expense Reports from Notification Email 

 

Approve Expense Reports in the Website 

1. There are two ways to access expense reports for approval: 

• Select Travel & Expense > Pending Approval. 
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• Alternatively, under the Tasks section, select Expense Reports to Approve. 

 

 

 

2. On the Expenses Reports to Approve page, click an Expense Report # from the Documents 

Pending Approval list. If you have a large list of reports, use the Filter option at the top of the 

page to quickly locate a report. 

 

 

 

 

3. The Expense Report Approval page opens. This page provides a detailed view of the 

expense report items. A brief overview of the report is given at the top of the page, followed 

by a list of all expense items, and ending with the Notes, FYI Notifications, and Edit 

Approval Routing sections. Review each detail on the expense report, including each 

expense item. 
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See the details on the following pages to understand how to use the Expense Report 

Approval page. 

 

 

  

https://corpay.com/


Expense Track     
Administrator Guide   

  

Page 103   |   Rev 1   |   11/25   |   © Corpay 2025. All rights reserved.   |   corpay.com  

 

The top portion of the page provides a high-level description of the expense report, 

including details such as the create date, total amount, and approved amount. 

 

 

 

4. Under the Detailed Approval for Expense Report section, review each expense item. 

 

 

 

• To approve an expense item, select the checkbox under the Approve? column. 

Declined items should remain unselected; if you have declined expense items, you 

can still process the report, but those declined items will not be processed for 

approval. Select the check box under Approve? to select all of the expense items in 

the list for approval. 
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Note: 

• If you decline an expense item, all details on the item will remain, such as any 

attached receipts, notes, and accounts coding information. 

• The Alerts column identifies the status of the expense item: green flag – item is 

ready for approval, yellow flag – item is not in compliance but can still be 

approved. 

• The Approved Amount and Quantity columns may be open for editing, but you 

cannot edit these columns for Corpay Corporate Mastercard transactions. 

Use the Expense column to perform additional functions. 

 

 

 

• To edit or split the coding of an expense item, click the edit ( ) icon or split ( ) icon. 

Note: If an expense item contains splits, the account code cannot be edited. 

• Any attached receipts can be viewed from this page by selecting the PDF 
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attachment link immediately under the item’s details. 

• For detailed information on each expense item, click the item name under the 

Expense column. This opens the Expense Item Approval page. 

 

 

 

The Expense Item Approval page allows you to view each expense item’s details, such as 

accounts coding splits, itemizations, credit card data, and receipts all in one screen. 

To edit or split accounts coding, click on the edit ( ) or split ( ) icon located next to HIDE. When 

a split is applied, it will appear under the HIDE section and the edit icon will disappear. 

 

Note: To view non-split account code details, click the edit icon. 
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You can view and scroll through receipts images on the right side of the page and download and 

print them as needed. If the attachment is not an image or PDF, a download icon will display. 

Once all information has been verified, you can reject or approve the item by selecting the Reject or 

Approve buttons located on the top right side of the page. You can also move to the previous or next 

expense item by clicking on the left and right ( ) arrows at the top of the page, as well as 

returning to the expense report by clicking Return to report. 

5. Back on the Expense Report Approval page, scroll down to the Note to Requestor and 

Approval Notes fields below the Detailed Approval for Expense Report section. 

Use the Note to Requestor field to enter information for the user that submitted the 

report. Your notes will be sent to the user through the Messages feature and/or email 

after saving. For example, if you change the reimbursement amount, you can alert the 

user through the requestor notes. Use the Approval Notes field to enter a note for 

multiple approvers involved in the approval process. When a note is added, other 

approvers in the route can view the notes entered in the field. 

Note: Clicking Clear Entries only resets the values entered in the Approved Amount, 

Quantity, Approval Notes, and Note to Requestor fields. 
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6. The bottom of the Expense Report Approval page holds the Discussion Notes, FYI 

Notifications, and Approval Routing sections. See the following pages to understand how to 

use each section. 

 

 

 

Notes: Use the Discussion Notes section to enter notes on the expense report for other 

users to view. For example, if multiple people need to approve the expense report, you can 

send a note to other approvers in the route to inform them on something related to the report. 

Each user will immediately see the note and be able to reply to it by clicking the Reply 

button ( ). 

Click Add Note to start. 
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Enter the user's name, subject line, and note. Click Submit when finished, which will 

generate an internal message that will notify all included users of your note. Add as many 

notes as necessary. 

Note: You can leave the To User field blank and still add the note for yourself, if necessary. 

FYI: Use the FYI Notifications to send notifications to specific users. These notifications 

are beneficial when other users need to be informed about an expense report, but do 

not need to approve it. To add a user for FYI notifications: 

a) Click inside the Add New User field. 

b) Enter a name in the field and select the username that appears in the search result, 

then click Add. 

 

 

c) The user will be added to receive an FYI notification. Add as many users as 

necessary. 
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d) To delete a user, click the  under Remove? A dialogue box will display to confirm you 

want to delete the user. Click OK to confirm. 

 

 

Approval Routing: Use the Approval Routing section to view each user in the approval 

route. A user with the word "active" next to their name is the current approver. The 

user with the word "open" next to their name needs to approve the report. A user with the 

word "closed" next to their name has approved the report. 

When adding users to the approver route, note the following: 

• A new approver can only be inserted after the current active approver. 

• The current approver or any previous approver cannot be moved up or down. 

• Only the user who added the approver can delete the added approver. 

• When there are multiple rules in effect, the selection of the approver under the rule 

determines where the approver should go in the rule chain. 

 

 

 

To add a user to the approval route: 

a) Click inside the Add New User field. 

b) Enter a name in the field and select the username that appears in the search result, 

then click Add. 
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c) The user will be added to the routing. To change the order of the routing, use the 

up and down arrows ( ). The user at the top of the list is first in line to approve. 

 

 

 

7. Return to the Expense Report Approval page and ensure everything is accurate. If so, 

click Process either at the top of the page or below Approval Notes. 

Note: If reimbursing an employee, the expense total cannot exceed the sum of each 

expense item. 
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8. You will be prompted to confirm your action. Click Submit to process the report. 

 

 

 

9. A message displays confirming that the expense report has been approved, including all 

approved expense items, and you are returned to the Expense Reports to Approve page. 
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Approve Expense Reports from the Notification Email 

If you are responsible for approving one or more users’ expense reports, you will receive an 

email notification whenever they submit a draft report. The email includes all details on the 

report, including the report title, total amount, each individual expense item (line item), and 

any coding applied. You can approve the expense report right form the email, which is 

convenient if you can’t access the website. 

Once you approve the email, you will receive a response email displaying your approval 

activity. 

You can approve expense reports from the notification email, by doing one of the following: 

• You can approve and decline individual line items by entering “x” or “y” (approve) or “n” 

decline in the brackets within the line item details. For example: (1)[x]... 1/EA1 Meals & 

Entertainment @ $24.67 (ID9642) 1001-7500-1401-70310 (100%) Fraudulent Charge? 

No 

• You can also approve or decline individual line items by adding your decision to the 

end of the line ID. For example: (ID9642=YES) (ID9643=NO). 

• If your instance of Expense Track is set up for default approval (such as all line items 

are approved by default), reply to the email with no comments. The system will 

approve or decline the report based on your defaults. 

• To Approve the entire Expense Report, reply to the email with "YES" or "Y" in the 

first line of your reply. To decline the entire Expense Report, reply to the email with 

"NO" or "N" in the first line of your reply. 

• Avoid using special characters in any of your replies. Incorrect values will cause an 

error and send the email back to the report submitter. 
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Approval Notification Email 
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Approval Response Email 

 

 
 
 

Reconcile Expense Reports 

Reconciling and releasing an expense report is the final step before the expense can be 

reimbursed to an employee or returned to your company's accounting system. This step 

occurs after all required receipts have been checked off and settled in the web portal. Once 

an expense is reconciled, it is marked as Fully Released, meaning everything on the 

report was accurate and can be added to accounting. This process is usually completed 

by someone in your accounting department. 

The following steps are involved with reconciling expenses: 

• Reconcile Expense Reports 

• Manage Reconciled Expense Reports 
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Reconcile Expense Reports Waiting for Receipts 

The reconcile process involves comparing the expense receipts with the expense report and 

releasing the expense for payment. Your company's accounts payable department typically 

completes this function. Depending on your Administrator's decision, you may be restricted 

to reconcile your own expenses or expenses by other users. 

Reconcile Expense Reports 

1. From the Expense Track main menu, select Travel & Expense > Pending Reconciliation. 

 

 

 

2. On the Pending Reconciliation page, select an expense from the Expense Report List and 

then click Reconcile Expense. Use the Filter drop-down at the top of the page to 

quickly locate an expense if you have a large list. 
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Note: Use the other features of the Pending Reconciliation page as necessary: 

• View Expense: Opens the Expense Report Detail page where you can make edits 

to the expense items. 

• Print Preview: Opens a printable version of the expense report. 

• Mark as Released: Reconciles the entire expense report without needing to reconcile 

each expense item. This step manually releases the expense report for payment, 

allowing you to skip the reconciliation process. 

• Decline Expense: Declines the entire expense report for reconciliation. 

• Export Current View: Allows you export the current page into an excel file. 

• Export all Rows: Allows you export all pages into an excel file. 

3. On the Reconcile Expense page, verify each approved expense item is appropriate and 

accurate. Select the check box in either the reconcile or decline column for each expense 

item. Then, click process to reconcile the expense item(s) or decline marked to decline 

the expense item(s). 
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4. The report will be released for payment and removed from the Expense Report List. 

Notice on the Expense Dashboard that the report is now in Fully Released status. 

 

 

 

Manage Reconciled Expense Reports 

Expense reports that have been released for payment display in the system for your viewing. 

You cannot make changes to a released expense report, but you can review its details and print 

it for your records. Also, note that you must have the appropriate permissions to access this 

feature. For access, contact your Administrator. 

Note: If the expense report comes from a Corpay Corporate credit card transaction, the total 

amount is not reimbursable. 

 

Review Managed Expense Reports 

1. On the Expense Track main menu, select Travel & Expense > Reconciled Expenses. 
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2. On the Reconciled Expenses page, select an expense report from the Released Expense 

Report List, and then click View Expense. 

 

 

 

3. The Expense Detail page opens. Review the expense report and expense 

items as needed. 
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4. To print an expense report, select one from the Released Expense Report List and then 

click Print Preview. This opens a printable version of the expense report opens. Use your 

web browser's printing option to print the report. 

 

Generate Reports 

 

Expense Track contains a suite of standard, preformatted reports on your account activity 

and information. Use these reports for record keeping and to analyze specific aspects of 

your program, such as cardholder spending, submitted and approved expense reports, and 

details on your Expense Track users. 

Click a link below to learn more. 

a. Accessing and Running Reports 

b. Report Samples 

 

Accessing and Running Reports 

Before you begin, it’s important to understand how to access and run reports. There are many 

parameters and prompts that allow you to filter and customize the data in each report. 

 

1. On the Expense Track home page, click Spend Manager > Ad Hoc Reporting. 
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2. On the Ad Hoc Reporting screen, select View > Repository. 

 

 

 

 

3. In the Folders column, select Public > Standard Reports > Expenses. 
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4. To run a report, click a report name in the Repository list. 

 

 
 

5. In the Input Controls window, select the variables to run the report and then click Apply 

to generate the report. Then, click OK to close the window. 
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Note: The options in the Input Controls window will vary by report type. 

 

 
 

6. The report will generate and display on screen. You have several options from here. 

See next page for field descriptions. 

Note: If there is no information to display based on your entered criteria, the message 

"The report is empty" will display. 
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Option Description 

Save 

 

 
 Allows you to save the report in another folder within the 

AdHoc Reporting application. For example, if you have 

another folder titled Corpay Reports, you can save your 

generated report into there. Selecting this option provides the 

opportunity to rename the report title and/or the report's 

description. 

 

Export 

 

 
 Allows you to export and save the report in another format. 

Options include: PDF, Excel (paginated), Excel, CSV, docx, 

RTF, ODT, ODS, XLSX, XLSL (paginated and non-

paginated), and PPTX. 

 

Undo/Redo/Undo All If you make a change to the report (filter the column view, 

perform a search, etc.) you can undo or redo a change or 

undo all of your changes. 

Edit (Options) 
Opens the Input Controls window and allows you to change 

the data and rerun the report. 

 

Zoom 

 

 
 Allows you to zoom in and out of the report on screen. 

 

Search Allows you to search the report for a specified keyword. 

Refresh Allows you to refresh the data in the report. 

 

 

7. If you are done viewing the report, click the Back button ( ) in the top left- 

corner or return to the Repository view and make another report selection or 

exit the application. 
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Report Samples 

See below for a list of available reports, their descriptions, input parameters, and report 

fields. This list will be updated as new reports are added. For image samples of reports, see 

the Expense Track Online Help. 

 

• Expense Accounting Code Detail 

• Expense Accrual Report - Aging Information 

• Expense Accrual Report - Cardholder Detail 

• Expense Accrual Report - Cardholder Summary 

• Expense Approver Detail 

• Expense Approver Summary 

• Expense Audit 

• Expense Cost Allocation Summary 

• Expense Default Coding by Cardholder 

• Expense Fuel Usage 

• Expense Location Activity 

• Expense Policy Violation Alerts 

• Expense Product Tax 

• Expense Spend Analysis by MCC 

• Expense Transaction Coding 

• Expense Transaction Detail 

• Expense User Information 

• Receipt Images Report 
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Expense Accounting Code Detail 

• Description: A list of cardholder transaction details by account code and customer ID. 

Use this report to analyze transaction details under each of your account codes and 

customer IDs. 

• Input Controls: Posting Start Date, Posting End Date, Transaction Start Date, 

Transaction End Date, Cardholder, Expense Item, Coding Value Filters (Type1Seg - 

Type3Seg5) 

• Fields: Account Code, Customer ID, Employee ID, Card Number, Last Name, First 

Name, Location Group, Location, Transaction Date, Posting Date, Expense 

Description, Vehicle Number, Reporting Level, Merchant Code, Merchant Name, 

Merchant Address, Merchant City, Merchant State, Merchant Zip, Merchant Group, 

Gallon, Status, Approval User, Approval Date, Export Status, Export Date, Card 

Transaction, Amount Coded, Transaction Amount, Credit Debit, Miscellaneous 1, 

Miscellaneous 2, Coding Type, company, Division, Department, GL Account 

• Additional Notes: The Excel export does not automatically format columns with 

exported currency or number fields. Users will need to manually format these 

columns for the values to display correctly. 

 

Expense Accrual Report - Aging Information 

• Description: Totals by user of transactions not ready for export as of the date run for 

the dates and users specified in the input controls. Totals are shown in aging 

columns of 0-30, 31-60, 61-90, 90-120, and 120+. 

• Input Controls: From Date, To Date, Users 

• Fields: Card Number, User, Email Address, Aged (0-30), Aged (31-60), Aged (61-90), 

Aged (91-120), Total Outstanding, Manager/Approver, Manager/Approver Email 

• Additional Notes: This report contains one line per user with totals separated by the 

aged columns. Also includes all transactions that have not been exported. 
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Expense Accrual Report - Cardholder Detail 

• Description: A detailed list of each transaction by cardholder that is not ready for 

export (pending submission, pending approval, pending reconciliation, etc.) as of the 

date run for the dates and users specified in the input controls. 

• Input Controls: From Date, To Date, Users 

• Fields: Cardholder, Email Address, Account Number, Transaction, Merchant Name, 

Transaction Date, Post Date, MCC, MCC Description, Expense Description, 

Manager/Approver, Manager/Approver Email 

• Additional Notes: This report contains one line for every transaction with coding. If 

the transaction contains split coding, it will display twice on the report with the split 

amount. Coding on this report is dependent on your accounts coding configuration. 

Also includes all transactions that have not been exported. 

 

Expense Accrual Report - Cardholder Summary 

• Description: Totals by user and coding value combination for the transactions that 

are not yet ready for export (pending submission, pending approval, pending 

reconciliation, etc.) as of the date run for the dates and users specified in the input 

controls. 

• Input Controls: From Date, To Date, User 

• Fields: User Email Address, Card Number, Transaction Amount, Manager/Approver, 

Manager/Approver Email, Coding segments setup with values coded (if coded) 

• Additional Notes: This report contains lines per cardholder and coding. Transactions 

are summarized by each user and the codings applied. Also includes all transactions 

that have not been exported. 
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Expense Approver Detail 

• Description: A detailed report of cardholders with approved and unapproved 

expense reports. Use this report to track the status, current assignment, days open, 

and total amount submitted for all cardholder expense reports. 

• Input Controls: Start Date, End Date, Approver, Transaction Type 

• Fields: Cardholder, Card Number, Posting Date, Transaction Date, Merchant, Expense 

Amount, Expense Description, Coded, Approver, Approved 

 

Expense Approver Summary 

• Description: Summary of transaction expenses assigned to approvers. The report 

identifies whether the approver has approved the expense or not. 

• Input Controls: Start Date, End Date, Approver 

• Fields: Manager, User Name, User ID, Email Address, Transaction Amount, 

Transaction Count, Coded, Pending Coded, Approved, Pending Approval 

 

Expense Audit 

• Description: Detailed audit information regarding modifications to the system made by 

users. Use this report to keep track of system changes by each user for audit 

purposes. 

• Input Controls: Start Date, End Date, Modified by User, Modification Type 

• Fields: User Name, User ID, Modification Type, Item Modified, Field Modified, Detail, 

Date Modified, Time Modified 

• Additional Notes: Changes made to a submitted expense report will display as PO 

instead of the expense report title. 
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Expense Cost Allocation Summary 

• Description: A summary of transactions totals by coding string for the filter criteria 

specified in the input controls. This report runs only at the company level. Use this 

report to track allocation of expenses to accounting codes. 

• Input Controls: Start Date, End Date, Coding Type 

• Fields: Coding Type, Accounting String, Transaction Count, Average Amount, Total 

Amount 

• Additional Notes: The Excel export does not automatically format columns with 

exported currency or number fields. Users will need to manually format these 

columns for the values to display correctly. 

Expense Default Coding by Cardholder 

• Description: A detailed list of all users with default account coding. Use this report to 

analyze cardholders that have set up a default accounting code for expense items. 

• Input Controls: User, Location 

• Fields: User Name, Location Code, Employee ID, Code Type, Seg 1, Seg 2, Seg 3, 

Seg 4, Seg 5 

Expense Fuel Usage 

• Description: A list of all fuel transactions for the filter criteria specified in the input 

controls. Use this report to track and monitor all fuel-related expenses submitted by 

your users. 

• Input Controls: Start Date, End Date, User, Merchant Name, Merchant State, Vehicle 

Number 

• Fields: Employee ID, Name, Transaction ID, Card Number, Merchant Name, 

Transaction Date, Post Date, Code, Product Description, Vehicle Number, State, 

MCC, Quantity, Price, Total, Discount 

• Additional Notes: The Excel export does not automatically format columns with 

exported currency or number fields. Users will need to manually format these 
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columns for the values to display correctly. 

 

Expense Location Activity 

• Description: Summary by location of the amount of transactions and users with 

activity for the specific date range. Displays active users and total users by location 

and includes all transactions regardless of status. Use this report to analyze 

transaction activity by locations in your company. 

• Input Controls: Start Date, End Date 

• Fields: Location Group, Location Name, Transaction Count, Total Amount, Average 

Amount, User with Activity, Active Users, Total Users 

 

Expense Policy Violation Alerts 

• Description: A list of all transaction with violations for the date range and policy 

specified in the input controls. Use this report to track users with transactions that 

are against your company’s expense policies. 

• Input Controls: Start Date, End Date, Policy Name 

• Fields: Policy Name, Expense Item, Transaction Date, Posting Date, User Name, Card 

Number, Merchant Category, Merchant Name, Transaction Amount 

• Additional Notes: Note the following: 

o This report displays a violation only if a transaction exceeds an amount 

specified by your company or the mileage is changed on an expense item 

after it is calculated. 

o The maximum amount must be below zero for the report to pick up a 

violation. 

o The Card Number field will populate if the transaction originated from a 

Corpay Corporate Mastercard transaction and will display NULL if the 

transaction is reimbursable. 
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Expense Product Tax 

• Description: A report of all tax collected for each expense. Use this report to view 

your collected expense taxes for reconciliation purposes. 

• Input Controls: Date Type (Posted Date, Transaction Date), Start Date, End Date, 

User, Merchant Name, Merchant State, Vehicle Number, Location, Location Group, 

Product Type 

• Fields: User Name, Card Number, Employee ID, Merchant Code, Merchant Name, 

State, Transaction Date, Posted Date, Product Code, Product Description, Quantity, 

Unit Price, Tax Collected, Tax Total, Discount, Total Amount, Transaction ID, 

Vehicle ID 

• Additional Notes: The Excel export does not automatically format columns with 

exported currency or number fields. Users will need to manually format these 

columns for the values to display correctly. 

 

Expense Spend Analysis by MCC 

• Description: An aggregate list of transactions by merchant category code (MCC). This 

report breaks down the amount spent for each MCC by total amount, average 

amount, and percentages of the total amount. A transaction count is also included. 

Use this report to analyze and understand your company's spending by each MCC. 

• Input Controls: Start Date, End Date, Manager, Users, Merchant Category Code, 

Locations 

• Fields: Merchant Category Code, Amount, Average Amount, Amount Percent of 

Total, Transaction Count, Percent of Total 

• Additional Notes: This report includes all transactions regardless of status. 

Summarizes amount spent, number of transactions, and averages by MCC and 

category name. The Excel export does not automatically format columns with 

exported percentages. Users will need to manually format these columns for the 

values to display correctly. 
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Expense Transaction Coding 

• Description: A list of all coded transactions for the criteria specified in the input 

controls. 

• Input Controls: Start Date, End Date, Transaction Type, Transaction Status, User 

Name, Location, Coding Status, Coding Value Filters (Type1Seg1 – 

Type3Seg5) 

• Fields: User Name, Card Number, Transaction Date, Posting Date, Merchant Name, 

Transaction Amount, Expense Description, Transaction Status, Reviewed Date (date 

coded), Approver, Approver ID, Approved Date, Exported Date, MCC, MCC 

Description, Account Code, Customer ID, Passenger Name 

• Additional Notes: The coding will display to reflect your accounting code 

configuration setup. 

Expense Transaction Detail 

• Description: A detailed report of transaction data for each expense report. Use this 

report as a closer view of transaction activity and the status of each transaction. 

• Input Controls: Start Date, End Date, User Name, Item, Transaction Type (Credit, 

Cash, Both), Location, Location Group, Transaction Status 

• Fields: User Name, Card Number, Transaction Date, Posting Date, Merchant Name, 

Transaction Amount, Expense Description, Transaction Status, Reviewed Date (date 

coded), Approver, Approver ID, Approved Date, Exported Date, MCC, MCC 

Description, Account Code, Customer ID 

Expense User Information 

• Description: A detailed list of all users within your instance of Expense Track. Use this 

report to analyze and track information on all of your users. 

• Input Controls: Created Start Date, Created End Date, Manager, Status 

• Fields: First Name, Last Name, Employee ID, User ID, User Email Address, Card 

Number, Location Code, Assigned Groups, Status, Manager Name, Manager Email 

Address, Create Date, Last Login 
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Receipt Images Report 

• Description: A detailed transaction report that displays each transaction in the 

selected date range as well as any attached receipt images. 

Note: Do not use this report’s previous version, Report with Receipt Images (Deprecated). 

• Input Controls: Start Date, End Date, GL Code, Segment 1-15, User IDs, 

Locations, Location Groups, Field Split Type IDs 

• Fields: Request #, Request Type, Expense Title, Purpose, Created For, Employee 

ID, Expense, Location, Address, Amount, Merchant Name, Merchant Address, 

Transaction ID, MCC Code, Accounts Coding Type, GL Account, Split Note, 

Attachment Name 

 

Extract Expense Data 

 

The Data Extract Utility tool allows you to set up scheduled or manual data exports as well 

as configure scheduled data imports. This action allows you to export expense data back to 

your accounting system. When a data extract is performed, two major actions occur: 

• The requested data is extracted from the Expense Track system database. 

• The extracted data is exported in a specified format using a chosen delivery method. This 

is sometimes also referred to as a report. 

Access to the Data Extract Utility tool allows Administrators to manage all configured data 

exports and imports. Administrators can edit existing exports, test configurations, and add 

or delete exports. 

Note: The following permissions are required for an Administrator to access and perform 

data extracts: 

• 2005 – Manage Expense Reports 

• 2006 – Run Expense Reports 

 

  

https://corpay.com/


Expense Track     
Administrator Guide   

  

Page 133   |   Rev 1   |   11/25   |   © Corpay 2025. All rights reserved.   |   corpay.com  

 

Setting up Exports 

Your Corpay Account Manager can help you determine the type of expenses you want to export. 

You can set the system to export expenses in one or more of the following statuses: 

• Reconciled Expense Reports (default) 

• Expense Drafts 

• Expense Reports in Approval 

• Expense Reports Pending Reconciliation 

This feature is beneficial as you don’t have to wait for expense reports to reach full 

approval before exporting them back to your ERP. When expense data is exported in one of 

these statuses, it is marked within Expense Track as exported. If an expense is marked as 

exported, but requires additional work (submission, approval, reconciliation, etc.), it can still 

be processed through the configured workflow, but cannot be exported again. 

Note: See the following: 

• Using Expense Drafts status will export expenses without coding at the time of export. 

Once the expenses have exported to your ERP, you will need to apply coding to them 

from within your ERP. To ensure all expenses are coded prior to export, do not use 

the Expense Drafts 

status. 

• This applies to only credit card transactions. Reimbursable expense reports must 

follow approval and reconciliation before they can be exported. 
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Running an Export 

1. To access the Data Extracts page, select the Settings icon ( ) > System > 

Data Extracts*. 

 

 

 

2. The Data Extracts page displays with options to run and test each data export. To 

manually run a data extract, click Run next to an extract. 
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3. If prompted to do so, select the values for each required input field per the 

extract configuration and then click Run. These fields vary depending on the set 

up of the extract.  

 

 

 

4. A confirmation message should display with a link to view and download the 

exported data files. 

 

5. To test a data extract, click Test* next to an extract. 

 

 

 

  

https://corpay.com/


Expense Track     
Administrator Guide   

  

Page 136   |   Rev 1   |   11/25   |   © Corpay 2025. All rights reserved.   |   corpay.com  

 

6. The same process follows and once the extract runs, you will be able to 

download the exported files. Testing a data extract ensures it will run as 

expected without actually removing any data from the Expense Track system. 
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